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CURA WEB ASSESSOR OVERVIEW  

Cura Assessor is an enterprise wide Governance, Risk and Compliance management software product used by 
a number of organizations in various industries. The Web version of Cura enables you to participate in your 
organization's risk management.  It is designed to run on Internet Explorer and is therefore easy to learn and 
use, even if you do not need to use it every day. 

 

This document is designed to guide you through the various functions of the Cura Web Client and the process 
of carrying out your daily risk management tasks. 

 

 

The screen images included in this guide are for reference purposes only and can differ on an 
individual basis, depending on the methodology, specific configuration and Assessor version. 

This document is based on a straightforward Risk/Control methodology.  

CURA TERMINOLOGY 

The following list of terms, will be used throughout this document. Revisit this summarized list on a regular 
basis to help you get to know the Cura interface, tools and processes: 

 

ASSESSMENT  

A register of risks and the associated controls that have been identified for a specific area. In risk management 
this is the process of identifying and evaluating risks. 

COLLAPSE FOLDERS  

This refers to closing or minimizing a range of folders when navigating in Windows Explorer or Cura. Select and 
click on the - (minus) sign to collapse the folders. 

CONTACT  

A person who must perform, supervise, manage or be responsible for the risk, control or task. 

CONTEXT  

Your Cura Solution is designed to group associated categories or items of information into a logical context - a 
specific circumstance under which these categories of events occur. This technique is particularly beneficial 
when you can filter the data of reports by either including or excluding these contexts. 
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CONTROL  

A control is a policy, standard, procedure or physical change that is put in place to eliminate or minimize risks 
or enhance positive opportunities. 

DOMAIN  

This refers to an area in which specific information is loaded. In Cura, this could refer to your company. 

EXPAND FOLDERS  

The opposite of closing folders. When navigating in the folder list of Windows Explorer or Cura, you can select 
and click on a + (plus) sign to expand the folders in that category. 

FILTERS  

A filter in Cura refers to a tool that you can use to set up rules which allow you to choose how to sort and 
group information. Your Cura Solution enables you to customize or filter the view and reports you are working 
with by letting you select which items to include or exclude. 

FOLDER LIST  

The working area of the screen where the program functions and folder contents can be accessed. 

KNOWLEDGEBASE  

Your Cura Solution structures the knowledgebase in a way that allows you to store, manage, and retrieve 
information about risks, incidents, controls and procedures. 

METHODOLOGIES  

Cura uses the term “methodology” to refer to a range of concepts. For example, the terminology you use such 
as risk or hazard, control or mitigation. It also defines the fields you want to record against risks and controls 
for evaluation purposes and the structure and terminology used in a knowledgebase.  

NODE  

In computer language, a node refers to a basic unit in which list, folders and tree data structures are built or 
programmed. 

REPORTS  

The potential of the reporting tools for your organization or company will become more apparent to you as 
you gain experience with your Cura Solution. 

RISK  

The chance of something happening that will have an impact on the objectives of an organization. 

SUB-DOMAIN  

In programming and software language this refers to an area that is part of, and literally falls under a larger 
domain. In the context of your company, your department could be set up as a Sub-Domain in Cura. 
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TASKS  

Depending on your circumstances, a task could be a range of actions or instructions such as a duty, 
responsibility for an action or a specific assignment. It is these tasks that Cura Solutions monitors, analyses and 
calculates. 

TEMPLATE  

A template refers to a blank assessment that is set up to serve as a guide for creating future assessments. The 
template assessments are normally empty, but the important thing is that when you need to create a new 
assessment the methodology, parameters and various contexts are available. 
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NAVIGATION 

CURA WEB ASSESSOR AREAS 

LOGIN SCREEN 

 

WEB INTERFACE 
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CURA WEB TOOLBAR 

 

  

 

The toolbar allows you to log off Cura Web Assessor, view system information, view help and return 

to your home page: 

 

 

Click on this icon to view the help file.  

 

Click on this icon to view Connection, User and Contact Information. 

 

Click on this icon to log out Cura Web Assessor. 

 

Click on this icon to view or return to your home page. 

 
Click on this icon to hide the side toolbar. 

 

 

Important:  You must use the Log Out option to exit the software and not just close your 
web browser. If you simply close the web browser window, the connection to the database 
will not be closed. 
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SYSTEM INFORMATION SCREEN 

Clicking on the system information icon will display the system information screen. The default tab on this 
screen is the Connection Information tab which provides information about the Cura Client and server 
versions you are using.  

 

 

USER INFORMATION  

Click on the User Information tab to view details of the user who is currently logged in. This tab also allows 
you to change your password.  
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CONTACT INFORMATION  

Click on the Contact Information tab to view the Contact and support details of Cura.  

 

 

 

SHORTCUTS MENU BAR 

The Shortcuts Menu Bar contains shortcuts to the different areas of the Cura Web Assessor interface: 
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 You can view Tasks that have been assigned to you by clicking on the My Tasks shortcut. 

 You can view active Assessments by clicking on the All Assessments shortcut. 

 You can run Reports that you have access to by clicking on the Reports Shortcut. 

 The My Bookmarks group allows you to add shortcuts to domains or Assessments for quick access. 

NAVIGATION MENU BAR 

The Navigation menu bar allows you to access specific items within the Domain structure. The item you are 
working with will be highlighted on the menu bar, for example, in the image below you can see that the user is 
working with a Risk called "Lack of management information."  
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SYSTEM NAVIGATION 

SYSTEM ICONS 

The following list shows the icons used to navigate through the system and their descriptions:  

 

 
Collapse Menu Bar 

 
Expand Menu Bar 

 
Open Filter dialogue 

 
Add Knowledgebase Items 

 
Refresh (specific area) 

 
Save item 

 
Minimize / restore work area 

 
Maximize work area 

 
Run report 

 
Show selected item 

 
Copy Assessment / Add item (e.g. Risk, Task etc) 

 
Delete item (e.g. Assessment, Risk, Task etc) 

 
Add selected item to favorites 
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Recurring Task / Set up schedule 

 
Link Items 

 
Delete Links 

 
Revise Due Date 

 
Browse / View Description 

ASSESSMENT ICONS 

The list below shows the icons used to indicate the status of an assessment:  

 

 
Active Assessment 

 
Active, Configured Parameters 

 
Locked Assessment 

 
Not Active, Configured Parameters, Static 

 
Active, Configured Parameters, Static 

 
Not Active, Static 

 
Active, Static 

 
Not Active, Parameters configured 

 
Not Active 

 
Locked Assessment 
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LIST AREA 

The list area will change to reflect information relating to the Shortcut you have accessed or the area you have 
navigated to, such as a list of Assessments, list of Risks etc.  You can access an item within the List Area by 
clicking on the highlighted link. 

 

 

NAVIGATING LISTS 

When clicking on the All Assessments, All Domains or My Tasks shortcut, if the list displayed is longer than 10 
items, you will need to navigate through the lists using the icons at the bottom of the page.   

 

 

 

 

Click on this icon to move to the First Page in the list.  

 

Click on this icon to move to the Previous Page in the list. 

 

Type in the page number you would like to move to and click on the 
Enter button on your keyboard. 

 

Click on this icon to move to the Next Page in the list. 

 

Click on this icon to move to the Last Page in the list. 

 

Click on this icon to Refresh the list. 
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WORK AREA 

The work area shows further details of an item which is selected in the list view, for example, in the image 
below details of the selected assessment are displayed: 

 

Note: You can click on the maximize button on the Work Area toolbar to maximize the Work Area for easier 
viewing. In the image below the assessment details pane has been maximized: 

 

 
  



Page 17 of 66  
19 September 2011 

Cura V3.7_Assessor Web 
Prepared by:  Kevin Holtzhausen (SA - Training) 

Version :0.2 

 

ALL ASSESSMENTS 

In Cura Web Assessor, the All Assessments link allows you to view a list of all active Assessments that you have 
the required permissions to view or view and edit.  You can select an Assessment that you need to view, 
update or add Assessment items to such as Risks, Controls and Tasks.  

 

This view also indicates how many assessable elements are contained within the Assessment, such as Risks or 
Controls.   

ACTIVE VERSUS INACTIVE ASSESSMENTS 

If an Assessment is active, this means that the Assessment will generate e-mail notifications to Contact people 
linked to the Assessment, such as Task reminders and Task Overdue Escalations.  Recurring Task items are also 
generated.   

 

Note: Only a Cura administrator should mark an Assessment as inactive. 

 

The following is an example of an Assessment which is Active: 
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MY TASKS 

You are responsible for updating or managing Assessment items such as Risks, Controls and Tasks that have 
been assigned to you. You can use the My Tasks link on the Cura Shortcuts menu to view the items for which 
you are responsible. This shortcut will only display the Tasks where you have been assigned as a Contact.  

The My Tasks link provides you with a list of all the Domain, Risk and Control Tasks to which you have been 
assigned: 

 

Note: By clicking on the column headings you can sort tasks by Date Last Changed, Start Date etc.  
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NAVIGATING DOMAINS 

In the Cura Web Assessor Domains, Sub-Domains, Assessments and Assessment items can be located by 
accessing various links that will form the navigation path. 

In Cura terminology, a Domain refers to an organization’s name.  Any organization, region or department 
falling under the main organization is referred to as a Sub-Domain.  An organization can have as many levels or 
Sub-Domains as required.   

Within an organization, the Cura Administrator will have access to Cura Assessor Rich Client which contains 
certain additional functionality.   

below is a Domain Structure that can be viewed within Cura Web Assessor. 
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NAVIGATING DOMAINS AND SUB-DOMAINS 

How to navigate Domains and Sub-Domains: 

 Click on the Navigation Shortcuts menu. 

 Click on the Domains shortcut.   

 A list of all Domains and Sub-Domains will be displayed in the right hand pane. 

 

 Click on a Domain or Sub-Domain link to view specific details. You can view the Assessments, Tasks 

and Sub-Domains falling under this Domain. 

 You can click on the Assessments, Tasks or Sub-Domains links to view the details of any of these 

items. 
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WORKING WITH MY BOOKMARKS 

Cura Web Assessor allows you to create Bookmarks (shortcuts) to specific items that you may need to access 
often.  You can also categorize these Bookmarks into Groups. 

 

 
CREATING A NEW BOOKMARK 

 

How to create new Bookmarks: 

 Navigate to an item on a list screen, such as a Domain, an Assessment or a Task. 

 Select the item and click on the "Add selected item to bookmarks" icon (yellow star).  

 The Name of the Bookmark will be added automatically, but you can change it.  

 The Bookmark will be added to the My Shortcuts folder by default.  

 Click on the Add button to save the Bookmark.  

 

 

 
CREATING NEW BOOKMARK GROUPS 

How to create new Bookmark groups: 

 Navigate to an item on a list screen, such as a Risk. 

 Select the item and click on the "Add Selected item to bookmarks" icon (yellow star).  

 The Name of the Bookmark will be added automatically, but you can change it.  

 Click on the New Group button.  

 Enter the Name of the Group and click on Add.  
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 The group is added to the My Bookmarks list  

 

 

 
MANAGING BOOKMARKS 

How to manage bookmarks:  

 Click on the Manage Bookmarks shortcut. 

 

 Click on the Rename button to change the name of a Bookmark group.  

 Enter the new Name of the group and click on Save.  

 

DELETING A BOOKMARK GROUP  

 Click on the Manage Bookmarks shortcut, select the Bookmark group you want to delete and click on 

the Delete button.  

 A confirmation message will be displayed, click on Yes.  
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ASSESSMENTS 

In Cura Web Assessor the All Assessments function allows you view a list of all active Assessments.  You can 
select the Assessment that you need to edit and add or update Assessment items such as Risks, Controls, 
Tasks, and Contacts that belong to the Assessment. 

WORKING WITH ASSESSMENTS 

In the Cura an Assessment is a category of Risks such as physical risks to a business or Risks resulting from non-
compliance with a specific section of legislation.  An Assessment contains identified Risks and their 
corresponding controls or mitigations and measures the impact of inherent and residual Risks and Control 
effectiveness.  These ongoing measurements can be analyzed by producing Reports. 

Assessments also contain Tasks or action items that are necessary to put in place Controls or mitigations and 
ensure their ongoing management.  Tasks or action items can also be attached to Risks or the actual 
Assessment if necessary.  

 

 
USING THE ALL ASSESSMENTS SHORTCUT 

In Cura Web Assessor the All Assessments shortcut lists all Active Assessments.   

 

How to find an Assessment: 

 Click on the All Assessments link on the Shortcuts menu: 

 

 All the Assessments in your Domain will be displayed in the list area, with details such as risks and 

tasks shown in the window below.  

 When you have located the Assessment you want to work with, click on the link to view the details.  

 You can click on the Maximize workspace button to allow you to view the Assessment details and 

make the necessary changes.  
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 You can now edit fields such as the Name and Description.  You can also add items from the 

Knowledgebase if applicable - which we will examine later. 

 Click on the Save Changes icon to save your work. 

Notes:  

 The Name field is the only compulsory field and contains the Assessment name. 

 The Description field allows for a more detailed description of the Assessment.  

 The Active checkbox indicates that this is an active Assessment which means email notifications will 

be generated and sent to the applicable Contact people. 

 

 

Remember: The Assessment shortcut does not display Assessments that are not marked as Active.  To 
locate an Assessment that is not marked as Active, navigate via the Domain structure. 

 

 
USING THE NAVIGATION PATH 

 

Since inactive Assessments will not be displayed in the All Assessment shortcut, you will need to navigate via 
the Domain structure in order to locate them. 

 

How to find an Assessment:  

 Click on the Navigation menu bar - click on the Domains link.   

 A list of the Domains will be displayed. 
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 Click on the name of the Domain or Sub-Domain relating to the Assessment.   

 Click on the Assessments link to view all Assessments linked to that Domain. 

 A list of all Assessments will be displayed. 

 Double-click on a specific assessment - the details will be displayed in the bottom details area. 

 You can make changes to the Assessment, Risks or Tasks directly in the details area.  

 

 

Hint: Once you have located an Assessment via the Domain structure, add a shortcut to your 
favorites folder, allowing you to find it quickly next time. 

CREATING ASSESSMENTS  

In Cura Web Assessor users cannot create new Assessments.  Users can only copy an existing Assessment and 
then customize the Assessment accordingly.  The Cura Administrator can set up ‘template’ Assessments that 
users can copy.   

Note: Assessments can be copied across Domains/Sub-Domains. 

 

 
COPYING AN ASSESSMENT 

How to copy an Assessment: 

 Navigate to the All Assessments view, click on the Assessment you want to copy and click on Copy 

Assessment: 

 

 The Copy Assessment window will be displayed: 
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 Locate the Assessment you want to copy in the left hand Copy from pane by expanding the Domain 

structure.  

 Select the Domain to which the Assessment must be copied in the right hand Add to pane. 

 The list of Domains/Sub-Domains in the Add to pane will only display the Domains/Sub-Domains that 

use the same methodology as the selected Assessment. 

 Select the copy Options: 

 Reset Tasks:  Tasks will be copied to the new Assessment without any dates. 

 Remove Contacts:  Copied Assessment items will not be assigned to any Contact people as in the 
original Assessment. 

 Clear Assessed Values: Any data in the existing Risks or Controls will be deleted. 

 Remove Links: Any links to other Assessments will be deleted. 

 Activate Assessment: Make the Assessment Active as soon as it is copied. 

 Go to copied Assessment: Go straight to the new copied Assessment 

 Click on the Copy Assessment button to complete the operation.  

 The copied Assessment will be displayed and you can edit it accordingly.  
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MAINTAINING RISKS IN AN ASSESSMENT 

A Risk is the chance of something happening that will have an impact upon objectives of the organization, e.g., 
non-compliance with legislation, fraud, natural disasters, competition, etc.  It is a source of potential harm, or 
a situation with a potential to cause loss.  You are responsible for updating or managing Risks, Issues, Controls 
and Tasks that have been assigned to you. 

 

 
ACCESSING RISKS USING ALL ASSESSMENTS 

In the Assessment view you can view a list of Active Assessments and the Risks or Controls associated with 
them.   

 Click on the All Assessments shortcut. 

 

 You will be able to view the number of Risks or Controls within an Assessment.   

 

 Click on the link to the Risks within a specific Assessment. 
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 The Risks pertaining to that Assessment will be displayed, with the selected Risk's details displayed in 

the details pane below:  

 

 

 
ASSESSING YOUR RISKS 

 

How to add and delete Risks in an Assessment: 

 Navigate to an Assessment, and click on the Risks link: 

 

 All the Risks within the Assessment will be displayed.   
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 Click on the Add New button on the toolbar to add a new Risk to the Assessment: 

 

 Enter a Name and a Description for the risk. 

 Click on the Risk Information tab and enter the data in the appropriate fields. 

 Click on the Save Changes button. 

The following tabs will be examined later: 

 Click on the Controls link to enter a new Control for this Risk.  You will only be able to add a 
Control once you have saved your changes. 

 Click on the Actions link to add a Task(s) to this Risk.  We will examine Tasks later. 

 Click on the Contacts link to add a Contact(s) to this Risk. We will examine Contacts in a later 
section. 

 Click on Links to link other Risks/Controls to this Risk. Links will be examined at a later stage in 
the manual. 

 Click on the Save button. 

 To edit a Risk, click on the name of the Risk that you want to edit, make the necessary changes in the 

details pane below the list of Risks and click on the Save icon. 

 To delete a Risk, click in the check-box of the specific risk and click on the Delete button: 

 

 A confirmation dialog box will be displayed, click on OK.  
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MAINTAINING CONTROLS IN A RISK 

Controls are measures that are put in place to reduce the impact should a Risk be realized.  You have to view a 
specific Risk in an Assessment to access the Controls tab where you can view, edit, delete or add Controls to 
that item. 

 

 
ACCESSING CONTROLS USING ALL ASSESSMENTS 

 

In the Assessment view you can view all Active Assessments and their associated Risks or Controls.   

 Click on the All Assessments shortcut. 

 You will be able to view the number of Risks and Controls within an Assessment.  

 

 Click on the link to the Controls within a specific Assessment: 

 The list of Controls pertaining to that Assessment will be displayed, with the selected Control's details 

displayed in the details pane below: 
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ADDING, EDITING & DELETING CONTROLS IN AN ASSESSMENT 

How to add and delete Controls: 

 Navigate to the list of controls for an Assessment, and click on Add Control.  

 

 Enter a Name and Description: 

 

 Click on the Control Assessment tab and select the required options.  

The following tabs will be examined later: 

 The Actions tab is used to add a Task(s) to a Control (most Tasks are associated with Controls and 
this would be the most common place to create one.) 

 The Contacts tab is used to add Contacts to a Control. 

 The Links tab is used to link other Risks/Controls to a Control. 

 Click on the Save button to save the new control.   
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EDITING A CONTROL 

 To edit a Control, navigate to the list of controls and click on the Control name. 

 Make the necessary changes in the details pane below the list of Controls.  

 

 To delete a Control, navigate to the list of Controls, click on the check-box of the Control and click on 

the Delete icon. 

 A confirmation dialog box will be displayed, click on OK to confirm. 

 

LINKING AND UPLOADING DOCUMENTS 

Depending on the methodology, an option exists to browse to a link from a URL field on a Risk or Control, as 
well as the option to either link or upload the document. 

 

How to create a link or upload to a document in Cura Web Assessor: 

 Navigate to the URL field where you want to create a link to a document. Click on the Upload file icon, 

then click on Browse to search for a document on your network: 
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 You will now be able to either Link or Upload the document by clicking on the relevant button. 

 

Note: 

 Linking to local URL (i.e. C drive) creates a fake path that cannot be accessed due to permissions 

restrictions. 

 Linking to documents will only work if the user links to a network resource that allows guest access. 
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STATIC ASSESSMENTS 

Static Assessments are linked to a Knowledgebase in such a way that you can only add Knowledgebase items 
to an Assessment.  For example, you will not be able to create a new Risk within a Static Assessment, you will 
be forced to select a pre-existing Risk description from a Knowledgebase.  

 

If you cannot locate a matching Assessment item, such as a Risk, within a Knowledgebase, you will have to ask 
an Administrator to add the new Risk.  Although you will be forced to select Risks from the Knowledgebase, 
Cura will allow you to create new Controls if required. 

 

The opposite of a Static Assessment is a Dynamic Assessment, where you can create new Assessment items 
such as Risks, and are not limited to using those from the Knowledgebase. 

 

Note: only an administrator can change an Assessment from Static to Dynamic and vice versa in Cura Web 
Assessor. 
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KNOWLEDGEBASES 

A Knowledgebase is a ‘library’ created by an organization, containing possible Assessment items such as Risks 
and Controls. A Knowledgebase can contain Risks or Controls linked to sections of legislation for compliance 
purposes.  Your organization may or may not use a Knowledgebase. 

 

You can add items from a Knowledgebase to your Assessment and then edit them accordingly. 
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ADDING KNOWLEDGEBASE ITEMS TO AN ASSESSMENT 

A Knowledgebase is a library of Risks and their Controls that has been set up by an organization.  Instead of 
capturing new Risks / Issues, you can also add these items to your Static or Dynamic Assessment from a 
Knowledgebase.   

 

 

Remember :  If an Assessment has been marked as Static, you can only add new Risks to an Assessment 
by selecting items to add from a Knowledgebase. 

 

 

 
ADDING RISKS TO AN ASSESSMENT FROM A KNOWLEDGEBASE 

 

How to add Risks from a Knowledgebase: 

 Navigate to the list of Assessments, select an Assessment and click on the Add Knowledgebase Items 

icon: 

 

 Select the entire knowledgebase to add every item contained within it to an Assessment,  or click on 

the Knowledgebase Name to open it further and select specific items. 

 The Knowledgebase information will be displayed.   

 Click on All Elements to view the categories within the Knowledgebase. 

 Open these categories further to select an individual Risk: 
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 Select the Assessment into which you would like to copy the knowledgebase item.  

 Click on the Copy Knowledgebase Items button.  

 A confirmation dialog box will be displayed, click on OK.  

 Click on the Close button.  

 

Important:  When adding a category or an item such as a Risk, any items falling under that 
category, or the Risk, (such as Controls), will also be copied into the Assessment. 

For example - when adding a new Risk, click on the browse icon next to the Risk name to access 
a Risk from the Assessment model: 

 

A list of Risks within the Assessment model will open and you can select which one you want to 
add to the Assessment. 
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Remember: If an Assessment has been marked as Static, you can only add new Risks to your 
Assessment by selecting items to add from your Knowledgebase. 

MANAGING TASKS  

Tasks are action items that are most commonly used on a Control or Mitigation.  A Task can also be linked to a 
Domain, Assessment or Risk. 

 

A Task can be a once-off occurrence or can be an action that needs to repeat according to a schedule.  A Task 
that needs to be repeated is known as a ‘Recurring Task,’ which we will examine later. 

ACCESSING TASKS LINKED TO A DOMAIN 

 

ACCESSING TASKS LINKED TO AN ASSESSMENT 
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ACCESSING A TASK LINKED TO A RISK 

 

ACCESSING A TASK LINKED TO A CONTROL 

 

ACCESSING TASKS VIA THE MY TASK SHORTCUT 

Click on the My Tasks link to view the tasks assigned to you. .  Note that all Domain, Risk and Control-related 
tasks are displayed in this list.  
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ADDING, EDITING AND DELETING TASKS IN AN ASSESSMENT 

 

 

Important : It is crucial that you create your Task in the correct place i.e. linked to a Risk or Control.  
If you do not create your Task in the correct area it will not reflect correctly in a Report. 

How to add and delete Assessment Tasks: 

 Navigate to a Control, and click on the Actions tab to access the Tasks for that control: 

 

 Click on the Add New icon to add a new Task: 

 

 Enter a Name for the Task. The Name field is the only compulsory field and contains the shortened 

Task name.  Make sure the name accurately describes the Task. 

 Enter a Description for the Task. The Description field contains a more detailed description of the 

Task.  

 Select the Category for the Task. This field allows you to select or type in a Task category that you can 

ask the rich client to filter on when previewing reports. 

 Select a Type of Task.  We will examine types of Tasks later. 

 Click on the Details tab to enter more detailed notes about this Task: 
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 Click on the Contacts link to assign a Contact to the Task.  We will examine adding Contacts later. 

 Click on Save to save the Task.   

EDITING A TASK 

To edit a Task simply click on the Task name, enter the new data and click on Save when you have finished 
making changes.  

 Note: if the administrator has set up the system to allow changes to be made to the Due Date, click 

on the Due date Revision button to make the changes.  

 

 If you have Modify rights, but not administrate rights, you will not be able to change the Baseline Due 

Date, but you will be able to select a Revised Due Date.  

 If you have Modify rights and administrate rights, you will be able to change the Baseline Due date 

and the Revised Due Date.  

 Enter a Reason for the changes and click on OK.  
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DELETING A TASK 

 To delete a Task, click on the Task Name and click on Delete. 

 

 A confirmation dialog box will be displayed, click on OK to confirm. 

TASK PRECEDENTS  

Task precedents are used to create a series of Tasks that have to be performed in a certain order. When one 
Task is completed, the next Task must start. Task precedents are usually set up by a Cura Administrator.  

 

 
VIEWING TASK PRECEDENTS 

 

How to view Task precedents: 

 Navigate to a list of Tasks and double click on a task to view the details. 

 Click on the Precedents tab. 

 A list of the Precedents is displayed.  
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EDITING A TASK PRECEDENT 

To edit a Task simply click on the Task name, enter the new data and click on Save when you have finished 
making changes.  

 

 

Important : you can view and edit Task precedents in the Web Client, but you cannot add new Task 
precedents 

 

 
CREATING DIFFERENT TYPES OF TASKS 

It is possible to create different types of Tasks such as Simple, Project, Audit / Test or Advanced. 

 

 On the Task tab, select an option from the Type drop-down menu. 

 

Depending on your selection under Type, the Details tab will change as follows: 

A Simple Task: 
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A Project Task includes the Notes tab, but also has a Project tab: 

 

An Audit / Test Task has additional tabs and fields: 

 

 

An Advanced Task includes the Audit fields, but also has Project fields: 
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ADDING A DOCUMENT IN A TASK 

You will notice that the Project, Plan, Audit/Test, Review and Clearance tabs all contain a “Reference” field. 
This field can be used to create a link to a network location or document, or an email address. 

 

 To create a link to a particular document, simply type in the location (i.e. address) of a document that 

is saved on a publically accessible network drive. This address can be copied from the Windows 

Explorer window, e.g.\\networkname\foldername\documentname.extension 

 

 

 

 Note! You must include the file extension type, e.g. documentname.doc / docx, for the address to be 

recognized. 

 Clicking on the browse or Search button when the field is empty will display the following error 

message: 
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 Creating a link to a document on your C:drive will display the error “This document is saved to a 

restricted location”: 

 

 

 When you have entered a valid document address a folder icon is visible – click on the icon to launch 

the file: 
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 When you have entered a valid email address, e.g. myname@mycompany.co.za,  a folder icon is 

visible – click on the icon to launch a new email window: 

 

 

 
ADDING A RECURRING TASK 

A Recurring Task is a task that needs to be repeated according to a schedule.  For example, fire extinguishers 
must be checked the first day of every month to ensure they are operational. 

 To create a Recurring Task, access the area within Cura where you want to add a Task e.g. a Control, 

and click on the Actions tab.   

 Click on the Add New icon: 

 

 Enter a Name, Type and Category.  

 Click on Schedule: 

  

mailto:myname@mycompany.co.za
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 Select the Recurrence Pattern, e.g., Monthly, and select the option that applies to your Task, e.g., the 

first Monday of every third month. 

 Select the Start date of the schedule 

 Select the End date of the schedule. 

 Click on the Specify Offset drop-down menu to select a different timezone for a user in another 

country/timezone.  

 Click on the Save & Close to save the schedule.   

 Enter the rest of the details as required.  

 Click on Save to save the recurring task.  
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UPDATING A RECURRING TASK 

 

As a Recurring Task serves as a template for all future instances of each recurrence, you will need to update 
the individual Task Items generated for each occurrence. 

 Open a recurring Task and click on the Task Items tab: 

 

 Click on the Task Item (Cura will display the next occurrence of the Task). 

 The individual Task screen will be displayed. 

 Update the Task item and click on Save. 
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WORKING WITH CONTACTS  

A Contact is a person within an organization’s database to whom a certain responsibility can be assigned, such 
as a Task Owner, Control Owner, Risk Champion etc.  A Contact person does not have to be a Cura User as they 
will still receive e-mail notifications from Cura, via the organization’s e-mail application. 

 

An item such as a Risk, Control or Task can have more than one Contact.  You cannot add new Contacts; you 
can only assign one from an existing Contact list.  When you delete a Contact, you are merely removing the 
Contact person from the item, Control or Task. You are not deleting the person from the database. 

 

 
ASSIGNING CONTACTS 

 

How to assign Contacts to a Task: 

 Navigate to a Task, and click on the Contacts tab: 

 

 The User who created the Task will be displayed as an Assigned Contact by default.  

 A list of all Contacts who have been used within that Assessment will be displayed in the right hand 

Available Contacts pane.  

 Click in the check-box next to the Contact name and then click on the left arrow in the middle to 

assign them to the Task.  
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 If you cannot see the name of the Contact in the right hand pane, enter your search criteria in the 

field next to the Available button and click on Search: 

 

 Note: this option will only search through the Available Contacts – contacts who have been used in 

this assessment.  

 A list of the Available Contacts that have met your search criteria will now be displayed under 

Available Contacts in the right hand pane 

 Click in the check-box next to the Contact names and click on the left arrow in the middle to assign 

them to the Task.  

 

 Click on Save to save the changes. 

SEARCHING ALL CONTACTS 

 If the Contact person you wish to assign cannot be found using the Available search function, you will 

need to search though the full Contact list to locate them.  

 Click on the Available button in the right hand pane so that it changes to All.  

 In the filter box, type in the person’s name or surname, then click on Search 
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 A list of Contacts that have met your search criteria will be displayed in the right-hand pane: 

 

 Note: the default search criteria used here is “name or surname contains” - the search will return all 

the contacts where the search criteria are found anywhere in their First Name or Surname.  

 Click in the check-box next to the Contact name in the right hand side and then click on the arrow in 

the middle to assign them to the Task.  

 

 Click on Save to save the changes. 
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DETAILED SEARCH OF ALL CONTACTS 

 You can create a detailed search of the full contact list by clicking on the All Contacts Search 

(magnifying glass) icon. 

 

 The following window will be displayed: 

 

 Enter your search criteria such as ‘Surname starts with Bo,’ then click on Apply: 

 

 A list of Contacts that have met your search criteria will be displayed in the right-hand pane.  

 

Important: It is recommended that you enter detailed search criteria in order to return the most 
accurate results.  
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 Click on the Contact name in the right hand side and then click on the arrow in the middle to assign 

them to the Task.  

 

 

ASSIGNING A ROLE TO A CONTACT 

 Once you have located the Contac and moved them to the left hand Assigned Contacts pane, you will 

need to assign a role to the Contact.  

 Select the Role to indicate the responsibility of the Contact person from the drop-down box. 

 Note: It is very important to set the roles correctly as the contact’s role will determine the email 

notifications that are sent to them and will also be displayed on Reports. 

 

 Click on Save to save the changes. 
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SETTING NOTIFICATIONS 

 Once you have selected a contact and assigned a role to the Contact, you will need to determine 

whether they should receive e-mail notifications or not.  

 If the contact must receive emails notifying them that they have been assigned as a 

Contact/Stakeholder, click on the Notifications tick-box. 

 

 Click on Save & Close to save the changes.  

 

 
REMOVING CONTACTS 

 

 Click on the Contact name in the left pane and click on the right arrow in the middle: 

 

 Click on Save to save the changes. 

 

 

Remember: You cannot edit a Contact’s details, but you can edit the role they have been assigned at any 
time by returning to the Contacts tab of a Risk, Control or Task.  If you cannot find a contact within the 
database, ask your Cura administrator to add them.  
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CREATING LINKS 

Cura Web Assessor allows you to link Assessment items from diverse methodologies, such as Risks and 
Controls, to other elements in the database. You can create one or multiple links in order to indicate a 
relationship between these items. For example - a Risk could be linked to an Incident, and an Incident could be 
linked to an Audit Finding.  

 

 

Note: The allowed Incoming and Outgoing Links settings are determined by your Cura Administrator, 
so your view may differ from the example presented here. You will be able to create new 
items/elements during the linking process itself. 

 

 
LINKING ITEMS 

 

 Access the Links tab of an Assessment item.  In this example we have accessed the Links areas of the 

Risk Assessment and Analysis tab.  

 Note: depending on your methodology configuration, your Links may be located on a Risk, Control, 

Assessment, a tab or any other element:  
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 Click on the Link Items button to create an outgoing link to a specific item: 

 

 

 Click on Search to find the items which can be linked. 

 

Note:  in the Search window, only those methodologies and elements specified in the methodology Workflow 
are visible. In the example below, only Causes can be linked in this area: 

 

 Click in the check-boxes next to each item to be linked. 

 Click on OK. The items are displayed in the Links list. 
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ADDING LINKED ITEMS 

 Click on Add Linked Items… to create and link a new element: 

 

 Searching on an Item will display all the relevant Assessments and domains.  

 Click on the Assessment where the item must be added and click on OK: 

 

 Capture the data for the new item and click on the Save button. 

 

 Click on Close to return to the original tab. 

 Click on Close to exit the element. 

Note: The names of these linked items now function as shortcuts, so that you can navigate to these specific 
areas with ease by double clicking on them. 
  

http://localhost/cura/assessor/
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PATHS 

Cura Assessor makes it possible to have a bird’s eye-view of how a specific Risk has been mapped out in 
relation to the associated Controls. When you are setting up assessments, use this function to either track or 
view how the Path of your risk model is unfolding. Paths are also very useful when working with a 
Knowledgebase because an element can be traced to its location and position in the Knowledgebase. 

 

 To view a particular Control’s path, navigate to the Control and click on the Path tab. 

 A particular Control may be used by more than one Risk and so, by viewing the Path tab, you can 

instantly see which Risks have the particular Control linked to it: 

 

Note: The Path tab will only be populated once you have saved and closed the Risk.  When you re-open this 
Risk, the Path tab will allow you to see how a specific Risk has been mapped out in relation to the associated 
Controls. 
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GENERATING REPORTS 

Cura Web Assessor allows you to run Reports, giving you to access vital information quickly and easily. 

THE REPORTS SHORTCUT 

This function allows you to run new or existing Reports.   

 To access this feature, click on the Reports link on the Shortcuts bar: 

 

 

 
GENERATING NEW REPORTS 

 

How to generate a new Report: 

 Click on the Reports link on the Shortcuts bar.   

 Click on the New Report shortcut: 

 

 Select the Report Category and Report you want to generate. 
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 Select the Area (Domain/s or Assessments) for which you would like to run a report by clicking on the 

browse button. Note: using the default All My Areas option will find all data you have access to, 

based on your logon ID.  

 

 When you have selected the Reporting criteria, click on the Run Report icon:  

 The Report will be displayed in a new window:  

 

 You can page through the Report by using the page navigation links: 

 

 You can also save the Report in various formats such as Adobe PDF,  Microsoft Office Word or Excel 

by clicking on the relevant icon: 

 

 For example, click on the Adobe Acrobat link   to open or save the Report in Adobe Acrobat 

format: 



Page 62 of 66  
19 September 2011 

Cura V3.7_Assessor Web 
Prepared by:  Kevin Holtzhausen (SA - Training) 

Version :0.2 

 

 
HISTORIC REPORTS 

The Historic Reports function allows you to display an instance of a Report that has been generated.   

How to display historic Reports: 

 Click on the Reports link on the Shortcuts bar.  

 Click on the Historic Reports shortcut.  

 All the Reports that have been generated previously will be listed: 

 

 Click on a Report name to view the instances of the report in the details pane below. 

 

 Select the instance of the report you would like to run in the details pane.  

 Click on the View icon on the details pane toolbar. 

 The report is displayed in a new window.  
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APPENDIX A 

WORKING WITH CONTEXTS IN AN ASSESSMENT 

A Context is a way to group Assessment items such as Risks or Issues into categories within your Assessment.  
Contexts enable these Risks or Issues to be categorized for easy reference when printing reports.  Examples of 
Contexts are sections or sub-sections of an act. 

 

The way in which a company’s methodology has been set up will determine if contexts are mandatory or not. 
When viewing an Assessment you will see the associated Risks, Contexts and Tasks: 
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ADDING, EDITING OR DELETING CONTEXTS 

How to add new contexts: 

 Navigate to an Assessment and scroll down on the Contexts list pane to access the Contexts in that 

Assessment.   

 Click on the Add New button to add a new Context to the Assessment: 

 

 Enter a Name and a Description and click on Save to save the new context: 

 

 You can now choose to go to Risks or add a Sub-Context.  A Sub-Context can create another level 

within your Assessment within which to group your Risks. 

 Click on the Add New button to add a new Sub-Context to the Assessment: 

 Enter a Name and a Description and click on Save to save the new context: 
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EDITING A CONTEXT 

 To edit a Context, select a Context from the list and make the necessary changes.   

 Click on Save when you have finished editing the context: 

 

 

DELETING A CONTEXT 

 To delete a context, select a Context on the Contexts list pane and click on Delete: 

 

 A confirmation dialog box will be displayed, click on OK.  

  



Page 66 of 66  
19 September 2011 

Cura V3.7_Assessor Web 
Prepared by:  Kevin Holtzhausen (SA - Training) 

Version :0.2 

 

DOCUMENT CONTROL  

 

Ver Updated Author Revisions 

3.5.0.0 22/04/2010 SR Updated layout for 3.5 release. Changed layout.  

3.6.0.0 03/05/2010 SR No changes required 

3.6.0.0 21/05/2010 CR Added section on “Adding a Document” to Task section 

3.6.0.0 18/06/2010 CR General edits incorporating ERM doc edits. 

3.6.2.0 13/08/2010 CR Refresh / F5 no longer logs user out. Removed ref. 

3.6.3.0 04/10/2010 SO Transferred document to new template 

3.7.0.0 07/02/2011 CR Spacing, TOC 

3.7.0.2 01/07/2011 CR 3702 Release. 

 


